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Introduction 

FelixCAD provides a high degree of compatibility with the AutoCAD® computer-aided design software 
from Autodesk, Inc. FelixCAD is compatible with drawings, commands customization, and 
programming interfaces from AutoCAD Release 14 and earlier. 
 
As an AutoCAD user, you will feel familiar with FelixCAD nearly right away. Try using FelixCAD for 
an hour or so, and you will recognize that FelixCAD does work in a way that is similar to AutoCAD.  
FelixCAD provides advanced functionality for CAD (computer-aided design) software that can be 
compared to the market-leading software product — but at a fraction of the price. 
 
FelixCAD is the best choice for integrating CAD workstations in a network, even with mixed AutoCAD-
FelixCAD configurations. You can open DWG® drawings and save your work as DWG® files, so that 
everyone in your company works with the same file format. FelixCAD lets you reference DWG files in 
your drawings at any time by using the XRef (externally referenced drawings) feature.  
 
FelixCAD is a viable alternative if you have thought about using a less-expensive CAD program, such as 
AutoCAD LT®, but don’t want to miss out on the advantages of customization and programming. 
FelixCAD has an open architecture, just like many other software programs. 

AUTOCAD COMPATIBILITY 
FelixCAD is compatible with AutoCAD in these crucial areas: 
 
• Drawing file format (DWG and DXF®). 
• Commands and input modes. 
• Customization. 
• LISP programming. 
• C/C++ programming interface. 
• Application-defined dialog boxes. 
 
This manual describes the similarities and differences between FelixCAD and AutoCAD. It is addressed 
to CAD users and programmers who are already familiar with AutoCAD and want start using FelixCAD 
productively in their work — right away! 

AUTOCAD MIGRATION TOOLS 
For those areas where FelixCAD is not 100% compatible with AutoCAD, our AutoCAD migration tools 
help ease the conversion process. These include: 

Menu Converter: 
MnuConv.Exe is a utility program that converts AutoCAD menu files (*.MNU) into FelixCAD menu 
files. It automatically converts the pulldown and icon menus of the DOS and Windows versions of 
Release 12 through 2000. If necessary, a file is created that contains all expressions that could not be 
converted. The tool is integrated into the Dialog and Menu Editor. AutoCAD menus can be converted 
under the File menu and the option AutoCAD Import. 
 
An AutoCAD *.MNS menu may be converted easily also, as it is generated from a *.MNU file of the 
same name. Many cases require only renaming the file from FILENAME.MNS to FILENAME.MNU 
then using the Menu Converter. 
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LISP Converter:  
A2FLisp.Exe is a utility program that interactively converts AutoLISP® files to the FLISP syntax. It 
shows you the location of possible problems and allows you to edit the source code, if needed. The tool 
is located in the \xconvert\a2flsip folder.  

Dialog Box Converter:  
Dcl2Dlg.Exe allows you to convert AutoCAD .dcl (dialog control language) files to FelixCAD .dlg files. 
The tool is included in the Dialog and Menu Editor. It converts dialogs directly before editing.  
 

 
Notes to Application Developers 

 
To convert AutoCAD dcl files, the source directory has to include the acad.dcl and the base.dcl. These files are 
containing predefined buttons, etc. which are required for converting the dialogs into the FelixCAD dlg Format. 
 
 

Dialog and Menu Editor:  
DME is a visual workbench for creating and modifying dialog boxes. You immediately see the result; no 
DCL programming skills are necessary to create dialog boxes. DME can also be used for application 
prototyping. You access DME within FelixCAD by selecting File > Resource Manager > Run Dialog 
and Menu Editor from the menu bar. 

Include File: 
FelixCAD provides the ads2fdt.h include file, which redefines ads_ function names to their fdt_ 
equivalents. You must recompile the ADS® source code using the ads2fdt.h header file and link the FDT 
libraries. For more information, read the online documentation in file FDTAPI5.pdf. Also, have a look at 
the ads2fdt.h header file and libraries that are provided with FelixCAD.  

Tools Folder: 
The \tools subdirectory on the CD-ROM contains sample files that may be useful to oem developers. 
Tools\dlgtutor contains examples for creating FelixCAD dialog boxes. Tools\dwgcnvrt contains an 
FLISP program example to convert drawing files. Tools\protlisp contains the utility to protect FLISP 
files. Tools\shapes contains font source files (SHP).  
 
In this manual, chapters 2 through 6 thoroughly discuss customization and programming compatibility 
issues for AutoCAD and FelixCAD. 

COMPATIBLE USER INTERFACE 
FelixCAD ships with its own user interface. It does, however, allow you to change the user interface to 
look more like AutoCAD Release 13, 14 and 2000. Changing the user interface involves executing a 
couple of commands and loading a few files. When you follow the steps listed below, FelixCAD will 
look like the Figure i.1. 
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Figure i.1: The FelixCAD user interface can be modified to look like AutoCAD’s. 

AutoCAD Compatible User Interface 
To change the overall user interface to look more like AutoCAD Release 13,14 and 2000, select File > 
Desktop Manager from the menu bar. You need to change the settings of the following options: 
 
• Command Line: Bottom. 
• Options: Off. However, we recommend that you set Options to Toolbar or Menu. 
• Properties: On. 
• Left Toolbar: Off. 
• Status Bar: On. 
 
To repeat a command, press the spacebar, right-mouse click or the Enter key, just as in AutoCAD.  

AutoCAD Compatible Commands and Aliases 
In the FelixCAD \cfg directory is an AutoCAD-compatible alias command file, facad15e.key (Note: 
AutoCAD's equivalent of this aliases file is called ACAD.PGP). Load this file with the Config 
command. The file contains the redefinitions (where FelixCAD commands are mapped to AutoCAD 
names) and abbreviations of commands similar to that found in AutoCAD. 

AutoCAD Compatible Menus  
To make the pulldown menus look like AutoCAD’s, load the facd15e.mnu menu file (found in the 
FelixCAD \support folder) with the Menu command. 

XYZ-Axes 

Command-line Prompt Area 

Status Line 

Toolbars

Cursor 

Menu Bar 
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Figure i.2: FelixCAD Fcad15e.mnu file 

 

AutoCAD Compatible Toolbars  
To make the toolbars look like AutoCAD’s, use the PalMan command to display the Palette/Desktop 
Manager dialog box. Scroll down to the end of the list. The ten AutoCAD compatible palettes (toolbars) 
are at the end of the selection list and are identified by the (FAcad) suffix. To open a toolbar, select a 
palette name, then click a Palette button. Repeat until all ten palettes are loaded. 
 
For more information about the FelixCAD user interface and the desktop layout, see the FelixCAD User 
Guide, Chapter 1 “Getting Started.” 

ADVANCED FEATURES 
FelixCAD distinguishes itself from AutoCAD Release 2000 (and earlier) by these advanced features: 
 
• Easy modification of the program’s desktop (user interface). 
• Context menus and dialog box support in many commands. 
• Easy to organize part (block) libraries. 
• Drawing Navigator manages non-graphical objects in drawings, such as layers, linetypes, text styles, 

user coordinate systems, and named views. 
• Visual tools to create and modify menus, palettes, dialog boxes, and icon menus. 
• Dialog and Menu Editor, Image Library Tool, drag & drop command buttons from palettes onto the 

desktop toolbars. 
• LISP interpreter for manipulating the drawing database. 
• C/C++ API with advanced features for event-driven programming functions via hook, callback, and 

notification mechanisms. 
• Delphi Programming Interface 
 
These features are discussed in greater detail below. 

Context Menus and Dialog Box Support 
Right from the start, FelixCAD has been designed for Windows integration. Wherever possible, 
FelixCAD displays a dialog box to allow you to make your choices.  
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Figure i.4: Many FelixCAD commands display a dialog box. This dialog box is displayed by the Settings command. 

When a precise specification (like coordinate input) is required, FelixCAD displays the command at the 
command prompt. In this case, in addition to the Command Prompt area information, FelixCAD displays 
a context-sensitive option menu or option toolbar. You can choose which you prefer with the DeskConf 
command: select Options > Menu or Toolbar. 

 
Figure i.5: Some FelixCAD commands display an Option Menu (top) or Option Toolbar, depending which interface you 
prefer. These options are displayed by the Circle command. 

Modifying the Desktop On-the-Fly 
At any time when FelixCAD is running, you can change the elements of the user interface (called the 
desktop). All items of the desktop (except pull-down menus) can be turned on and off at run-time.  
 
The toolbars can be easily customized on-the-fly: 
 
• Simply drag and drop palette buttons to the toolbar. 
• Define or modify a toolbar button by clicking it with the right mouse button, which brings up the 

command configuration dialog box. 
• Icon menu support has been added in FelixCAD v4.0 to allow users to visually select options. 
 

 
Notes to Application Developers 

 
After leaving FelixCAD the current desktop configuration is saved into the FCADx.ini file. To access the desktop 

settings out of a FLISP- or fdt-program you can use the global system variables DTCMDLINE, DTOPTIONS, 
DTPROPBAR, DTTOOLAREA, DTTOOLAREASTYLE and DTSTATUSLINE. 

 
 

Drawing Navigator 
The Drawing Navigator provides fast access to important non-graphical information of all the drawings 
that are open. You can view and check the names and status of layers, linetypes, dimension styles, or 
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user coordinate systems defined in the drawings. You can use the Drawing Navigator to organize and 
manipulate these tables in your drawing. 
 
You access the Drawing Navigator with the Xplorer command. 

 
Figure i.6: The Drawing Navigator lists all data known about layers, linetypes, dimension styles, and user coordinate 
systems for all open drawings. 

Part Library Manager 
The Part Library Manager allows you to easily manage and organize parts, blocks, and symbols, as well 
as project drawing files and your company’s template drawings.  
 
A drawing library is set up quickly with the Part Library Manager with visual control. This tool collects 
all or selected files that are located in a folder (or subdirectory). Descriptive information on the parts or 
drawings is stored within the drawing files. 
 
You access the Part Library Manager with the Library command. 

 
Figure i.7: The Parts Library Manager organize parts, blocks, and symbols, as well as project and template drawings. 
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Additional User Interface Tools 
FelixCAD is delivered with a number of tools and features that let you efficiently customize the user 
interface without wasting time in studying the syntax of support files: 
 
• The Dialog and Menu Editor (DME) allows you to design and lay out your menus, palettes, and 

dialog boxes in an visual environment; knowledge of programming is not required. You access the 
DME via the DlgEdit command. See Chapter 6 for more details. 

• The Image Library Tool organizes images (raster type: i.e. *.BMP files, WMF files, and SLD slide 
files) in libraries. The images can be used in icon menus, dialog boxes, palettes, and toolbars. You 
access the Image Library Tool via the ImageLib command. 

 

 
Figure i.8: The Image Library Tool displays raster images stored in a library file. 
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1. Drawing Database Compatibility 

FelixCAD provides full support for reading and writing drawing files produced by AutoCAD:  
• Read DWG files from Release 2.5 up to Release 2000, as well as all versions of AutoCAD LT. 
• Write DWG files in formats that are read by AutoCAD Release 12 up to R2000, as well as by all versions 

of AutoCAD LT. 
 
In addition, FelixCAD allows you to import and export files in DXF format. 
The proprietary drawing file format of FelixCAD is .flx. From the beginning, the .flx file format was designed 
to be extremely similar to the .dwg format. This ensures that there is nearly no loss of data when exchanging 
drawings between the two CAD systems. 

In drawing database compatibility, FelixCAD provides these features: 
• DWG Roundtrip. 

If you open an AutoCAD drawing, you now you have the possibility to ”Roundtrip” all unsupported 
AutoCAD entities. That means, that while being edited in FelixCAD, unsupported AutoCAD entities 
remain unchanged and invisible the background.  If the drawing is saved in AutoCAD drawing format 
again, all entities including these unsupported AutoCAD entities will be written back to the file. 
 

 ”Roundtripped” AutoCAD Entities: 
ARCALIGNEDTEXT 
BODY 
IMAGE 
LEADER 
MLINE 
OLE2FRAME 
PROXY 
RAY 
REGION 
RTEXT 
SOLID3D 
TOLERANCE 
WIPEOUT 
XLINE 
XRECORD-OBJECTS 

 
”Roundtripped” AutoCAD Table Information: 

DICTIONARYWDFLTOBJTYPE 
DICTVAR 
IMAGEDEF 
MLINESTYLE 
OBJECTPOINTER 
PLACEHOLDEROBJECT 
VBAPROJECTOBJECT 
WIPEOUTVAROBJECT 

 
 
• Blocks and WBlocks, including those with attributes, are handled just like in AutoCAD. You can insert 

.flx, .dwg, and .dxf files into drawings. 
• You can attach externally referenced drawings (xrefs). Again, you have the choice of inserting .flx, .dwg, 

and .dxf files into drawings. 
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• Supports user coordinate systems (UCS). 
• Supports model space and paper space. 
• Supports grouping of drawing objects. 
• You can use the same font files as in AutoCAD (.shx), including BigFonts. 
• You can use the same linetype definition files as in AutoCAD (.lin). 
• You can use the same hatch pattern definition files as in AutoCAD (.pat). 
 
FelixCAD provides an high degree of DWG and DXF compatibility. It means you have a secure investment 
when you want to set up a new computer-aided design workstation, or who want to add CAD workstations in 
a mixed configuration. 

OPENDWG ALLIANCE 
Our firm, Felix Computer Aided Technologies GmbH, is a member of the OpenDWG® Alliance 
(http://www.opendwg.org ) and we support its efforts. FelixCAD, employs the DWG read-write 
technology provided by the OpenDWG Alliance. 
 
Prior to the founding of the OpenDWG Alliance, FelixCAD used the AutoDirect DWG/DXF 
read-write technology from MarComp. The AutoDirect technology has since become the basis of 
the OpenDWG Alliance’s OpenDWG Toolkit. 

DRAWING OBJECTS 

FelixCAD supports many AutoCAD objects, converts some AutoCAD objects to another format, and does 
not display a small number of objects. The following sections describe how FelixCAD deals with all objects 
found in AutoCAD Release 2000. 

Supported AutoCAD Objects 
The following table lists the geometric entities that are identical in AutoCAD and FelixCAD: 

Table 1.1: AutoCAD Objects Supported by FelixCAD 

AutoCAD-FelixCAD Object Comments 

3DFACE 3D face entity. 

ARC Arc entity. 

ATTDEF Attribute definition. 

ATTRIB Attribute of a block insertion.  

CIRCLE Circle entity. 

DIMENSION  
(R12 and earlier) 

Dimension (complex entity). 

BLOCKS &  WBLOCKS Block insertion (block reference, internal & 
external). 

LINE Line entity. 

POINT Point entity.  

LWPOLYLINE 
(R14 and later) 

Lightweight Polyline (complex entity).  

MTEXT  
(Release 13) 

Multi-line Text entity. 

POLYLINE Polyline (complex entity). 

SOLID Filled 2D face entity. 

TEXT Text entity. 

VIEWPORT Paper space viewport. 

http://www.opendwg.org/
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Note: Dimensioning and hatching is associative in FelixCAD, as in AutoCAD. 

Converted AutoCAD Objects 
The following table lists DWG geometric entities that are converted by FelixCAD: 

Table 1.2: AutoCAD Objects Converted by FelixCAD 

AutoCAD Object FelixCAD Entity Comments 

TRACE  
(Introduced to 
AutoCAD with 
version 1) 

3DFACE In AutoCAD’s drawing database definition, the 
TRACE object is identical to the 3DFACE 
object. 
When reading an AutoCAD drawing, FelixCAD 
converts the TRACE object to a 3DFACE 
entity. 

ELLIPSE  
(Release 13) 

POLYLINE In AutoCAD, the ELLIPSE object draws true 
ellipses and elliptical arcs as a planar object 
with no thickness. 
When reading an AutoCAD drawing, FelixCAD 
converts the ELLIPSE object to POLYLINE 
entities with an elliptical shape, as in AutoCAD 
Release 12. 

SPLINE  
(Release 13) 

POLYLINE In AutoCAD, the SPLINE object draws a true 
non-uniform rational B-spline (NURBS).  
When reading an AutoCAD drawing, FelixCAD 
converts the SPLINE object to POLYLINE 
entities with a spline shape. 

DIMENSION 
(Release 14)) 

BLOCK In AutoCAD, the DIMENSION object is an 
optimized dimension.  
When reading an AutoCAD drawing, FelixCAD 
converts the DIMENSION object to a BLOCK 
entity containing the dimension elements 
(lines, arrowheads, and text), as in AutoCAD 
Release 12. 

 
AutoCAD Object 

 
FelixCAD Entity 

 
Comments 

 
HATCH  
(Release 14)) 

 
BLOCK 

 
In AutoCAD, the HATCH object is an optimized 
hatch pattern.  
When reading an AutoCAD drawing, FelixCAD 
converts the HATCH object to a BLOCK entity 
containing the hatch element (lines and points), 
as in AutoCAD Release 12. 

Ignored Objects 
The following table lists AutoCAD geometric objects that are not displayed by FelixCAD. When objects 
are not displayed in FelixCAD, they are maintained in the .dwg file. This ensures that the objects remain 
intact when displayed by AutoCAD.  

Table 1.3: AutoCAD Objects Not Supported by FelixCAD 

AutoCAD Object Comments 

SHAPE  
(AutoCAD with version 1) 

Shape entity used in shapes, complex linetypes, and 
tolerances. 

3DSOLID  
(Release 13) 

ACIS object. 
 

BODY  ACIS object. 
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(Release 13)  
LEADER  
(Release 13) 

Dimension: leader line and text. 

MLINE  
(Release 13) 

Multiline. 

OLEFRAME  
(Release 13) 

OLE (object linking and embedding) object.  

ZOMBIE  
(Release 13) 
PROXY 
(Release 14) 

ObjectARX-defined object. 

RAY  
(Release 13) 

Semi-infinite construction line. 

REGION  
(Release 13) 

ACIS object. 

TOLERANCE  
(Release 13) 

Dimension: geometric tolerance. 

XLINE  
(Release 13) 

Infinite construction line. 

IMAGE  
(Release 14) 

Raster image object. 

 

ENTITY PROPERTIES 
AutoCAD objects have the following properties: Layer, Color, Linetype, Visibility flag, Linetype scale 
factor, Space assignment (Model or Paper space), and Thickness (entity extrusion). All of these properties 
are supported by FelixCAD and they have the same characteristics as in AutoCAD. 
 
For example, FelixCAD applies the same color palette to objects as does AutoCAD. There are 255 RGB 
colors and two logical colors, BYLAYER and BYBLOCK. 
 

 
Note for Applications Developers 

 
When an entity extrusion (thickness) is applied TEXT and POINT entities, the thickness is not displayed by FelixCAD. 
 

Extended Entity Data 
Extended entity data (xdata) can be attached to drawing objects (via appropriate programming functions). 
Xdata is stored in the drawing database as in AutoCAD. The method to access xdata is identical in both 
software packages.  
 
Xdata are maintained when exchanging drawing files (via DWG and DXF) between the two programs. 

 

BLOCKS 
Like AutoCAD (especially Release 12 and earlier), FelixCAD organizes groups of different types of 
entities as blocks in the BLOCK section of the drawing database. This includes: 
 
• User-defined blocks. 
• Dimensioning blocks, stored as anonymous blocks. 
• Hatch blocks, stored as anonymous blocks. 
• Application-defined anonymous blocks. 
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• External references (Xref). 
 

These blocks and their organization in the FelixCAD database corresponds to the AutoCAD database. 

SYMBOL TABLES 
Symbol tables store non-graphical objects in the drawing database. FelixCAD manages and organizes 
symbol tables like AutoCAD does. These symbol tables are maintained in the TABLES section of the 
drawing database.  

Table 1.4: Symbol Tables Supported by FelixCAD 

Symbol Name Comments 

LAYER Layer names and settings. 
LTYPE Linetype names. 
STYLE Text styles names and settings. 
UCS User coordinate systems. 
DIMSTYLE Dimensioning styles. 
VIEW Named views. 
VPORTS Drawing viewports. 
APPID Registered application identifiers for extended entity data. 

Groups 
In AutoCAD R13, a section OBJECTS has been added to the drawing database. Similar to tables, this 
section allows the organization of non-graphical objects in individual sub-sections called “Dictionaries.” 
AutoCAD maintains two dictionaries: Groups (references of entities that belong to a group) and Multiline 
Styles. In addition, applications can store and manage non-graphical application data in separate 
Dictionaries. 
 
As in AutoCAD, you can group entities in FelixCAD with the Group command. However, FelixCAD 
stores groups in a table named GROUPS. This is slightly different from AutoCAD, but has the advantage 
that you can apply the same LISP and C API functions on groups as you do to layers, linetypes, etc. 
 
FelixCAD lets third-party applications store and manage their non-graphical application data in a table 
named APPDATA. Again, this is slightly different from AutoCAD but has the advantage that you can 
apply the same LISP and C API functions on groups as with layers and linetypes. 

 
 

Notes to Application Developers 
 

Since version 4.0, FelixCAD allows you to access symbol table entries via entity names (enames). This means that 
applications can now use the entmake and entmod functions to create and modify table entries, respectively.  
The new tblobjname function returns the entity name of an existing table record. 
 
Attaching extended entity data (xdata) to entries of symbol tables is not yet supported. This has been allowed in 
AutoCAD since Release13. 

Planned Enhancements 
The following properties of non-graphical objects were introduced with AutoCAD Release 13 but are not 
yet supported in FelixCAD’s symbol table:  
 
• Dimstyle Table: Dimension families, a secondary set of dimension styles for specific groups of 

dimensioning, such as linear and radial dimensions.  
• Linetype Table: Complex linetypes, which contain text and/or shapes. 
• Multiline Dictionary: Multiline styles. 
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SYSTEM VARIABLES 

Most of AutoCAD’s system variables are supported in FelixCAD. This means that you find the most 
recently settings restored when you exchange drawings between the two systems. 
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2. Command Compatibility 

Most FelixCAD command names and options are comparable to those available in AutoCAD.  

ENTERING COMMANDS 
When you want to draw a line, you start the Line command in FelixCAD, just as in AutoCAD: 

> line
From point: [pick]
To point: [pick]
To point: [pick]
To point: c (as in 'Close' the shape, just like AutoCAD)

 
To relocate drawing objects, you apply the Move command in FelixCAD, as in AutoCAD: 

> move
Select objects: l
1 selected.
Select objects: [Enter]
*** 1 selected. ***
Basepoint: [pick]
Second point of displacement: [pick]

 
These examples, like most of FelixCAD’s drawing and editing commands, are equivalent in their names 
in both systems, and are essentially similar in the way they operate. On the whole, commands behave 
similarly in both systems.  

Command Line Area and Text Window  
Like AutoCAD, FelixCAD provides a command line area and a text window. Notice that the above 
examples show that the FelixCAD command prompt is an angle bracket, >, rather than AutoCAD’s 
Command: prompt. 
 
Press F2 to display the Command History text window, which allows you to view the command history. 
Opening the text window is also useful when evaluating and testing LISP expressions. 

 
Figure 2.1: The FelixCAD command line. 

You can use the MS Windows standard Ctrl+C and Ctrl+V commands to copy and paste text from and 
to the command line and text window. As an alternative, the user can click on the up and down scroll 
arrows located at the right side of the FelixCAD command line. This allows the user to review command 
history 'in place' a few lines at a time.  

Command Options 
As an AutoCAD user, you will feel familiar with most of the options that FelixCAD presents for 
commands. 
 
The primary difference from AutoCAD is the context-sensitive pop-up menu, called the option menu, that 
displays the options available for the command. As an alternative, you can set up a option bar instead of 
the context menu. See the Figure i.3 in the Introduction for a look at the FelixCAD context menu and 
option bar. 

 
Notes to Application Developers 

Programmers can use context-sensitive context menus, called “option menus,” in applications. As you probably know 
from AutoLISP, the initget function allows you to define option keywords for user input, which are checked by 
subsequent getxxx functions.  
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In FelixCAD’s LISP, your routine displays the option menu when you set the bit-coded flag to 256. Here is an example 
of its use: 

(initget (+ 1 256) “Width Height Settings”)
(getpoint “Specify point or select option: “)

 
This LISP routine displays the following option menu: 
 

 
 
The FelixCAD system variable InitGetFlag turns on the option menu as the default when set to 1. This system 
variable was added in FelixCAD version 4.0; note that neither InitGetFlag nor flag 256 work in AutoCAD. 

 

Dialog Boxes vs. Command-line Input 
From the beginning, FelixCAD has used dialog boxes for any command where it made sense. For 
example, FelixCAD’s Layer command has always displayed a dialog box, whereas AutoCAD didn’t 
switch its Layer command to a dialog box until Release 14. 
 
Whereas earlier releases of AutoCAD required multiple steps of command line entries to adjust its 
settings, FelixCAD has always offered clearly arranged dialog boxes to let you select your preferences at 
one go. A good example is the Settings command. 
 
On the other hand, whenever a command requires precise coordinate and geometric input, FelixCAD 
presents the command’s prompts at the command line, such as the Line and Move commands shown at 
the beginning of this chapter. 

COMMAND PREFIXES AND MODIFIERS 
FelixCAD is compatible with many of AutoCAD’s command prefixes, such as transparent commands and 
point filters. The following sections detail the similarities and differences between the two CAD 
programs. 

Invoking Dialog Box Commands 
Since Release 9, AutoCAD commands that invoke a dialog box usually (but not always) have the DD 
prefix (short for “dynamic dialog”), such as DdStyle and DdLModes (the 'Layer' command with dialog 
box).  
 
With AutoCAD Release 14, several commands have been changed to dialog boxes. In these cases, the 
dialog box version got the name of the command line variant, whereas the command line variant now 
requires a hyphen prefix, such as -Style and -Layer.  

“Q” Commands 
In contrast, FelixCAD versions 3.1 and 4.0 added command-line variants to existing dialog box-based 
commands. To continue the tradition of the command naming convention, these commands are identified 
by the Q prefix in the command line version. For example, the Layer command displays a dialog box and 
the QLayer command displays prompts at the command line. More example are shown in Table 2.1. We 
call these “Q commands.” 
 
A consistent command naming convention between FelixCAD and AutoCAD cannot be achieved for 
several commands, especially with introduction of the hyphen-commands in Release 14. The following 
table shows some of the differences: 
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Table 2.1: Examples of Command Naming Differences Between AutoCAD and FelixCAD 

AutoCAD R2000 
Command Line 

FelixCAD 
Command Line 

AutoCAD R2000 
Dialog Box 

FelixCAD 
Dialog Box 

AttDef QattDef DDAttDef AttDef 
Insert Qinsert DDInsert Insert 
-Style Qfont or –Style Style Font 
-Layer Qlayer or –Layer Layer Layer 
-Mtext Qmtext MText MText 

Input Methods and Keywords 
Coordinates and angles are specified in FelixCAD in the same way as in AutoCAD. Similarly, object 
snaps and object selection, during a command, correspond to the same methods that you know from 
AutoCAD. FelixCAD provides the same XYZ point filters for coordinate input.  
 
Overall, FelixCAD accepts the same special keywords you know from AutoCAD. The following table 
summarizes these methods and keywords: 

Table 2.2: Input Methods and Keyword Similarities Between AutoCAD and FelixCAD 

Input Method or 
Keyword 

Comments 

Press Spacebar or 
Enter  

At the > command prompt, the spacebar or Enter key recalls 
the previous command.  
Within a command, the keystrokes accept the default option. In 
some cases, the keystrokes terminate the command. 

@ symbol The @ sign references the coordinates of the last point. 
From Establishes a temporary reference point for specifying a 

subsequent point. The From keyword is used in combination 
with other object snaps and relative coordinates. 

@10<< If the<< expression is followed by Enter, the angle of the 
current cursor position will be used for the input. 

 
Input Method or 
Keyword 

Comments 
FelixCAD Menu 

  
ACAD Equivalent Menu 

Object snap options: 
  Int 
  App 
  Mid 
  Cen 
  Qua 
  Per 
  Tan 
  Ins 
  Node 
  Nea 
 
  None 

  
 

Intersection. 
Apparent (implied) intersection. 
Endpoint. 
Midpoint. 
Center. 
Quadrant. 
Perpendicular. 
Tangent. 
Insertion point. 
Node (point entity). 
Nearest. 
 
None 
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Object selection options: 
  Wp 
  Cp 
  F 
  L 
  P 
  R 
  W 
  C 
  Si 
  All 

  

 
Window polygon. 
Crossing polygon. 
Fence. 
Last. 
Previous. 
Remove. 
Window. 
Crossing. 
Single. 
All objects in drawing. 

Point filters: 
  X 
  Y 
  Z 
  x,y 
  y,z 
  x,z 
  x,y,z 

References an existing point location and filters out unwanted 
X, Y, or Z-coordinate values. 
Note that there is a small difference: In FelixCAD, you do not 
type the point prefix; instead you type x, y, or z and (optionally) 
the numerical coordinates, as shown in the following examples:  
From point: 5,y
Y-Coordinate: 6

To point: x,y,z
X-Coordinate: 1.9
Y-Coordinate: 2.8
Z-Coordinate: 3.7 

 

Transparent Commands  
As in AutoCAD, many FelixCAD commands can be applied transparently. This means that you can use 
such commands in the middle of another command using the ‘ (apostrophe) prefix. This is particularly 
useful in using commands like Move or Copy in conjunction with Zoom, for instance. 

 
Note to Application Developers 

 
FelixCAD applications which are defined by the defun function via C:command can be called transparently. To allow 
this, your function must not contain the function command itself; recursion is not allowed. 
 

 

COMMAND ALIASES, ACCELERATOR KEYS, AND SCRIPTS 
FelixCAD is compatible with many of AutoCAD’s shortcuts, such as command aliases and accelerator 
keys. The following sections detail the similarities and differences between the two CAD programs. 

Alias Names for Commands  
As in AutoCAD, you can define aliases for command names. In most cases, these are one, two, or three 
characters, such as L for Line and C for Copy. 
 
AutoCAD aliases are limited to executing commands; they cannot handle options. In contrast, FelixCAD 
allows aliases to execute commands and options, such as ZE for Zoom Extents. 
 
Another use for command aliasing is to assign familiar AutoCAD command names to corresponding 
FelixCAD commands. For example, you could assign POLY3D to the 3DPOLY command. 
 
The Config command displays Configuration dialog box; the Alias Commands tab lets you create, 
modify, and delete aliases for command names. 
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There is a difference in where and how AutoCAD and FelixCAD store the alias names of commands. 
AutoCAD users will be familiar with the ACAD.PGP file which contains aliases; FelixCAD stores its 
aliases in a .key file of the user’s individual configuration directory, typically the Cfg folder. The .key file 
contains a section named [ALIAS COMMANDS] where the alias names are defined using the following 
format: 

<Alias>=<Command name or command macro>

For example, here are the several lines from the Felix40.Key file: 
[ALIAS COMMANDS]
2D=PLAN;_W
3D=3DVIEW
A=ARC

 
Figure 2.2: The dialog box for creating and editing command aliases. 

Notes to Application Developers 
 
FelixCAD allows you to use alias names in commands defined by LISP and FDT. 
 
Unlike AutoCAD, a FelixCAD alias can consist of a macro, such as Zoom;E. 
Accelerator key definitions may contain the transparent command prefix ( ’ ) and the Esc characters ( ^^ ); command 
aliases, however, ignore these special characters.  

Accelerator Key Assignments  
When you install FelixCAD out of the box, the function key mapping is similar – but not identical — to 
that of AutoCAD. The following table illustrates the differences:Table  

2.3: FelixCAD’s Default Function Key Assignments 

Function Key FelixCAD Command Comments 

F1 Help Defined by Windows. 
F2 ’Tscreen Flipscreen 
F3 … Not defined. 
F4 … Not defined. 
F5 … Not defined. 
F6 … Not defined. 
F7 ’Tgrid Grid toggle. 
F8 ’Tortho Ortho toggle. 
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F9 ’Tsnap Snap toggle. 
F10 Menu bar. Defined by Windows 

 
For function key assignments identical to AutoCAD, use the Config command to display the 
Configuration dialog box; select the Hotkeys tab. Here you define function keys and other accelerator 
keys, such as the Ctrl+Alt combination. Function and control key definitions are stored in the same .key 
file as command aliases. 

 
Figure 2.3: The dialog box for creating and editing function and accelerator keys. 

Control Keys 
FelixCAD defines several Ctrl keys in the same manner as AutoCAD. The following table lists the 
default control-key assignments. 

Table 2.4: FelixCAD’s Default Control-Key Assignments 

Control Key FelixCAD Command Comments 

Ctrl+B ’Tsnap Snap toggle. 
Ctrl+C Copy to Clipboard. Defined by Windows. 
Ctrl+G ’Tgrid Grid toggle. 
Ctrl+L ’Tortho Ortho toggle. 
Ctrl+N ^^New Open a new drawing. 
Ctrl+O ^^Open Open an existing drawing. 
Ctrl+P ^^Print Print (or plot) the drawing. 
Ctrl+S ^^Save Save the drawing. 
Ctrl+V Paste from Clipboard. Defined by Windows. 
Ctrl+X Cut to Clipboard. Defined by Windows. 
Ctrl+Y ^^Redo Redo the undo command. 
Ctrl+Z ^^U Undo the previous command. 

 
Note: The apostrophe ( ’ ) prefix indicates a transparent command. The double caret (^^) is the Esc key, 
which cancels the currently-active command. 
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Command Scripts 
As in AutoCAD, you can create scripts with FelixCAD. The Macro command (known as Script in 
AutoCAD) executes command sequences in the same manner as AutoCAD. 
 
The Command Line Editor of FelixCAD is a built-in tool to paste portions of the text window into it and 
then edit and test command sequences. You then can copy the script into the Windows clipboard to save 
your script file with a text editor like Notepad. 

 
Note to Application Developers 

In FelixCAD, the default extension for macros (script) files is .mcr, whereas AutoCAD uses the .scr extension. You 
can, however, give the macro file any file extension. 

For Further Information 
Detailed information on the topics discussed in this section are found in the Customization and 
Programmer’s Guide. 

COMMAND SET COMPARISON 
As described above, you can use AutoCAD command names and command syntax in most cases, but 
FelixCAD has its own set of additional commands. There are numerous commands not found in 
AutoCAD. However, there are many commands that have an equivalent functionality in AutoCAD. 

Unique Commands 
The following table lists some of the unique commands not found in AutoCAD: 

Table 2.5: Commands Unique to FelixCAD 

FelixCAD Command Comments 

Arender Renders the current drawing model. 
Allows you to rotate the rendered image, as well as zoom in and 
out. 

C:BatProc Batch processing utility for plotting and converting drawings. 
(Application) 

Chain Creates a 2D polyline with even width. 
DelPartial Breaks an entity in a manner slightly different from the Break 

command and is probably more intuitive in several cases. 
Flip Mirrors entities and deletes the originals. 
Hide Saves an independent drawing containing the hidden line 

representation of the current drawing.  
The FHide (fast hide) command displays the hidden line 
representation of the current drawing. 

Intersect Intersects two lines. 
PartLib The Part Library manager organizes part and symbol libraries. 
C:Rejoin Repairs broken lines and arcs (an FDT application). 
Xplorer Displays the Drawing Navigator. 

 

Controlling Toolbars and Windows 
The table below lists the commands that allow flexible handling of FelixCAD’s palettes (known as 
toolbars in AutoCAD). 
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Figure 2.4: A FelixCAD palette (toolbar). Click the small box in the upper-left corner to dismiss the palette. Click the arrow 
in the lower-right corner to toggle between horizontal and vertical orientation. 

 

Table 2.5: Commands for Controlling Palettes in FelixCAD 

FelixCAD Command Comments 

DeskConf Determines the layout of the program’s desktop. 
PalClose Closes the specified palette. 
Palette Opens a palette specified by filename. 
PalMan Palette Manager. 
PalNext Open a specified palette at the next available position (can be 

applied in command macros, menus, and in the programming 
interfaces). 

 
FelixCAD can handle up to four drawings in one session, each with up to four viewports – for a total of 
16 windows. FelixCAD provides the following commands to organize and control multiple windows: 

Table 2.6: Commands for Controlling Windows in FelixCAD 

FelixCAD Command Comments 

SaveAll FelixCAD can handle up to four drawings in one session. This 
command saves all open drawings. 

Wcascade Cascade all drawing viewport windows. 
Wclose Close the current viewport window. 
WiconArr Arrange drawing viewport icons. 
Wopen 
 
QWOpen 

Opens a new viewport window of the current drawing (maximum. 
four viewports.) 
Opens a new viewport window of the current drawing (command 
line variant) 

Wtile Tile all drawing windows. 
WtileHor Tile all windows horizontally. 
WtileVer Tile all windows vertically. 

 

Commands With Enhanced Options 
FelixCAD has enhanced several commands by providing them with additional options. The table below 
lists examples of commands with enhanced options. 

Table 2.7: Commands with Enhanced Options in FelixCAD 

Command Option Comments 

2DFace Append Continues 2D face creation at the edge of an existing face. 
Arc Append Appends an arc to arc or line in tangent direction. 
Circle TTT Creates a circle tangential to three selected elements. 
Copy Rel.Point Copies objects relative to a specified point. 
Line 
 
 

Segments 
Append 
TT 

Draws subsequent line in individual segments. 
Appends a line to another line or arc in tangent direction. 
Creates tangent to arcs or circles. 
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Move Rel.Point Moves objects relative to a specified point. 
Offset BothSides Copies an entity parallel on both sides. 
Polyline Append Appends a polyline to another line or arc in tangent 

direction. 
 

Preference and Configuration Commands 
A number of AutoCAD commands serve solely to set preferences for subsequent commands. In fact, 
these commands modify system variables.  
 
In FelixCAD, you do not find command-line versions of commands that set system variables. The setting 
of preferences is done in dialog boxes, primarily with the Settings command. The Settings dialog box has 
tabs for grouping related preferences: Object Snap, Snap/Grid, Draw Modes, Construction Points, View 
Parameters, and Edit Parameters.  

 
Figure 2.5: The Settings dialog box controls many system variables. 

The following table shows AutoCAD commands and their FelixCAD alternatives specific to setting up 
drawing preferences. The table also lists the system variable related to these commands. 

Table 2.8: Commands and System Variables for Setting Drawing Preferences 

AutoCAD Command FelixCAD Command Related System Variables 

AutoSnap DynaSnap (setvar “DYNASNAP” bitcoded)  
 0 = off 
 1 = Marker on 
 2 = Tooltip on 

Aperture ’PrecPar or 
’Settings 

(setvar “SNAPBOX” number) 

AttDisp ’Drawmode or 
’Settings > Drawmode 

(setvar “ATTMODE” mode) 

Base ’InsBase (setvar “INSBASE” point) 
BlipMode ’Settings > View Parameters (setvar “BLIPMODE” 0 | 1) 

 0 = Off 
 1 = On 

DragMode ’Settings > View Parameters (setvar “DRAGMODE” 0 | 1 | 2)  
 0 = Off 
 1 = On 
 2 = Auto 

Elev ’Elevation and (setvar “ELEVATION” number) 
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’Thickness (setvar “THICKNESS” number) 
Fill ’DrawMode or 

 ’Settings > DrawMode 
(setvar “FILLMODE” 0 | 1) 
 0 = Off 
 1 = On 

Grid ’PrecPar or  
’Settings > Snap/Grid or 
’Tgrid 

GRIDMODE and GRIDUNIT 

IsoPlane ’PrecPar or  
’Settings > Snap/Grid 

(setvar “SNAPISPAIR” 0 | 1 | 2 ) 
 0 = Left 
 1 = Right 
 2 = Top 

Limits C:Limits (setvar “LIMMIN” number) 
and (setvar “LIMMAX” number) 

LtScale ’DrawMode or 
’Settings > DrawMode 

(setvar “LTSCALE” number) 

Snap ’PrecPar or 
’Settings > Snap/Grid or 
’Tsnap 

SnapMode, SnapStyl, SnapAng, 
SnapUnit, and SnapBase 

Units UnitSetup LUnits, LUPrec, AUnits, AUPrec, 
AngDir, DefLUnits, DefLUPrec, 
DefAUnits, DefAuPrec, and 
DefAngDir 

ViewRes ’CircleRes (setvar “CIRCLERES” number) 
 

Other Command Differences 
In addition to differences in commands for setting drawing preferences, FelixCAD handles a number of 
other AutoCAD commands differently. The following table lists these differences. 

Table 2.9: Differences Between AutoCAD and FelixCAD Commands 

AutoCAD Command FelixCAD Command Comments 

Divide 
Measure 

Divide or Point Segments 
Measure or Point Measure 

The equivalent commands Divide 
and Measure are existing as LISP-
Application commands. To divide 
elements with points you can use 
the Point command. 

Dview Perspective view. Exists as a dialog command. 
MVSetup 
(mvsetup.lsp) 

UnitSetup and  
FCTemplate 

MVSetup assists with setting up a 
new drawing in AutoCAD.  
In FelixCAD, third-party 
applications are available that 
provide a similar Setup Wizard to 
set the preferences for new 
drawings.  
TIP: You can set the defaults for 
new drawings with the UnitSetup 
command, and by setting a default 
prototype drawing via the system 
variable FCTemplate. 

Plot 
(CmdDia = 0) 
 
Plot 
(CmdDia = 1) 
 

Print 
 
 
QPrint 

The name and the design of the 
dialog boxes are different in 
AutoCAD and FelixCAD, but the 
commands do a similar job. 
In AutoCAD, the Plot command 
displays prompts on the 
command line when the CMDDIA 
system variable is set to 0 (off). 
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In FelixCAD, CmdDia is 
unknown. Instead, use the Qprint 
command. 

Preview Print In AutoCAD, the Preview 
command displays a full-page 
preview of the drawing. The 
preview is based on the current 
plot configuration, as defined by 
the Plot command. 
In FelixCAD, the plot preview 
feature is integrated in the Print 
command. Select the full-page 
button to display a full-page plot 
preview of the current drawing.  

VPLayer ViewPort Layer or PLayer  
QViewPort Layer or PLayer 

In AutoCAD, the VPLayer 
command makes a layer visible in 
one or more paperspace viewports 
and invisible in other viewports.  
In FelixCAD, use the command 
ViewPort or QViewPort with 
option Layer or PLayer to control 
layer visibility. 

Vpoint 
DDVPoint 

SetViewDir 
3DView 

These commands set the viewing 
direction for a 3D viewpoints.  

 

Unsupported Commands 
The following groups of AutoCAD Release 2000 commands are not found in FelixCAD: 
• ACIS and 3DStudio commands. A 3D solid modeler is not yet implemented in FelixCAD. 
• ASE (AutoCAD SQL Extension) commands: AseAdmin, AseExport, AseLinks, AseRows, 

AseSelect, and AseSqlEd. FelixCAD does not provide an interface to external database files.  
 
The following table lists commands not (yet) supported in the current version of FelixCAD. They may be 
added in a future version. 

Table 2.10: AutoCAD Commands Not (Yet) Supported by FelixCAD 

AutoCAD Command Comment 
Audit Invokes drawing integrity auditing.  
DsViewer Arial view, also known as “birds-eye view”. 
DxbIn Imports specially coded binary files; not supported and not 

intended to be supported. 
EdgeSurf Generation of edge defined surface. 
Load FelixCAD does not support the SHAPE entity. 
Minsert In AutoCAD, MINSERT uses the same initial prompts as the 

INSERT command and proceeds likewise the ARRAY 
command.  
Note: In AutoCAD, blocks inserted using MINSERT cannot be 
modified or exploded. 

Recover Repairs a damaged drawing. Exists for FLX-Files 
(FLXRECOVER). 

Shape FelixCAD does not support the SHAPE entity. 
Trace Traces are stored as entities of type SOLID, which have exactly 

the same description in the drawing database as TRACE 
entities. 
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Xbind Binds dependent symbols of an XREF (externally referenced 
drawing) to a drawing. 
A similar command is provided by third party developers. 

 

Notes to Application Developers 
Some of the subtle differences of the more common AutoCAD commands and their equivalent FelixCAD 
commands are listed in the following table:  

Table 2.11: Subtle Differences Between Commonly Used AutoCAD and FelixCAD Commands 

AutoCAD 
Command 

FelixCAD 
Command 

Comments 

QSave Qsave In AutoCAD, if the drawing is named, the drawing is saved 
without requesting a filename. If the drawing is unnamed, 
the Save Drawing As dialog box comes up and allows to 
save the drawing under the file name the user specifies.  

Array Qarray In FelixCAD, the Array command is processed differently 
from AutoCAD’s Array command.  
However, the QArray  command corresponds to the 
AutoCAD command in operation and options. 

Mirror Qmirror In FelixCAD, the Mirror command is processed differently 
from AutoCAD’s Mirror command.  
However, the QMirror command corresponds to the 
AutoCAD command in operation and options. 

Offset Offset 
 
Qoffset 

In FelixCAD, the Offset command is processed different 
from AutoCAD’s Offset command.  
The QOffset command corresponds to the AutoCAD 
command in operation and options. 

Text Qtext In FelixCAD, the Text command uses a dialog box. 
FelixCAD’s QText command corresponds to AutoCAD’s 
Text command in operation and options. 

AttDef QattDef The native FelixCAD AttDef command uses a dialog box. 
QAttDef corresponds to the AutoCAD AttDef command in 
operation and options. 

AttEdit QattEdit The native FelixCAD command AttEdit uses a dialog box.  
QAttEdit corresponds to the AutoCAD AttEdit command 
in operation and options. 

-Layer Qlayer or  
-Layer 

The FelixCAD QLayer command corresponds to AutoCAD 
R14’s -Layer command in operation and options. 

-Linetype LoadLtype The native FelixCAD command Linetype uses a dialog 
box.  
LoadLtype is the command line version of the AutoCAD –
Linetype. Note that the command sequence is different. 

-Mtext Qmtext The native FelixCAD Mtext command uses a dialog box. 
The FelixCAD QMtext command corresponds to AutoCAD 
R13’s -Mtext command in operation and options. 

View Qview or  
-View 

The FelixCAD View command uses a dialog box.  
QView corresponds to AutoCAD’s View command in 
operation and options. 

-Style Qfont 
-Style 
 

The FelixCAD QFont command corresponds to AutoCAD 
R14’s command -Style in operation and options. 
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3. Customization Compatibility 

One of the reasons for AutoCAD’s success was the ability users had to customize the CAD software. 
FelixCAD also supports a customizable user environment. These customization features are not identical 
to AutoCAD’s. We invite you to check out the advantages of customization possibilities implemented in 
FelixCAD. 

SUPPORT FILES & CUSTOMIZATION TOOLS 
From the beginning, Felix Computer Aided Technologies GmbH made a special effort to provide 
customization tools for the user that do not require knowledge on support file syntax or even 
programming skills. FelixCAD provides intuitive methods and visual tools that allow you to adjust the 
program’s desktop and the method of communication with the program — tailored to your individual 
needs in an easy-to-use way. 

CAD Support Files 
In FelixCAD, you use: 
 
• The same font files as in AutoCAD (.shx), including BigFonts. 
• The same linetype definition files as in AutoCAD (.lin). 
• The same hatch pattern definition files as in AutoCAD (.pat). 
 
The FCOMPILE command compiles text font source files (.shp) to binary text font files used in 
FelixCAD (.fsh).  

Menus and Toolbars 
As you probably already know, AutoCAD defines the bulk of its user interface items in a single menu 
file. 
 
FelixCAD choose another direction: the program uses individual files to define different aspects of the 
user interface. Each file covers different menu types and user interface items in separate files. The 
advantages are: 
 
• The maintenance and testing effort is reduced. To fix an error, you don’t need to access to the entire 

menu system. 
• Applications do not need to change a complete system when enhancements or changes are provided 

to the end user. For example, a third-party developer can add a single palette or icon menu to the 
system, without modifying other components of the menu system. 

 
The following table lists the file types related to the menu types and user interface items utilized by 
FelixCAD: 

Table 3.1: File Extensions Used by FelixCAD Support Files 

File Extension Comments 

.mnu Pull-down menu. 
Located in \support folder. 

.mnp Palettes (toolbars). 
Located in \support folder. 

.mni Icon menu (image menu). 
Located in \support folder. 

.mnt Tablet menu. 
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Located in \support folder. 
Desktop.cfg Vertical and horizontal toolbars of the program’s desktop. 

Located in \cfg folder. 
 

Dialog and Menu Editor 
The Dialog and Menu Editor (DME) allows you to design and lay out your menus and palettes in a visual 
environment. Knowledge of programming is not required.  
 
You access DME within FelixCAD by selecting File > Resource Manager > Run Dialog and Menu 
Editor from the menu bar. See Chapter 6 “Programmable Dialog Boxes” for more information. 

Image Library Tool 
The Image Library Tool allows you to assemble and organize images that can be used in several ways. 
Icons and other screen grabs incorporated in image libraries can be displayed in icon menus, toolbars, 
palettes, and application dialog boxes. Image libraries created and maintained with the ImageLib program 
are stored in files with extension .ilb. 
 
FelixCAD’s image libraries in are similar in nature to AutoCAD’s slide libraries. You can import entire 
slide libraries (.slb) from AutoCAD into a FelixCAD image library. But FelixCAD’s Image Library Tool 
provides features not available in AutoCAD’s slide libraries: 
 
• Beneath slides, you can store bitmaps (.bmp) and Windows Metafiles (.wmf) in image libraries. 
• You can use icons and images from your libraries in icon menus, dialog boxes, palettes, and 

toolboxes. 
• The ImageLib program is a Windows program with easy-to-use import and export of image files. 
 
To start the ImageLib program, select File > Resource Manager > Run Image Library Tool from the 
FelixCAD menu bar.  

 

MENU SYNTAX 
The syntax in files that define pull-down menus, icon menus, palettes, and toolboxes is different from the 
one used by AutoCAD. However, this syntax is easy to understand. If you use FelixCAD’s Dialog and 
Menu Editor, you don’t even have to know the syntax. 
 
FelixCAD provides a conversion tool for menu files created for AutoCAD.  

Menu Converting 
The Dialog and Menu Editor (DME) program converts the pull-down menu (POP) and icon menu 
(ICON) sections of AutoCAD menu files (.mnu) to corresponding FelixCAD menu files (.mnu and .mni). 
The utility handles AutoCAD menu files from DOS Release 12 and 13, and Windows Release 12 through 
2000. To import menus into the DME, please select the File>AutoCAD Import>Menus… option. 
 
You convert a menu file with AutoCAD syntax to FelixCAD format, as follows: 
1. Select in the File pull-down menu of the DME the option AutoCAD Import>Menus… 
2. Click the Open button. Then the Converter displays the AutoCAD Release dialog box. 



3. Customization Compatibility 

28 

 
Figure 3.1: Select an .mnu format from the AutoCAD Release dialog box. 

3. Select the format of the AutoCAD menu file. 
4. Choose the type of menu to be translated: pull-down menu or icon menu.  
5. Click OK. Notice that the converter program prompts you to select the source menu file.  
6. Select the .mnu file and click Open. Notice that the menu file is read and displayed. This may take a 

few seconds to complete. 
7. Click Convert to run the conversion. As the conversion takes place, the program displays the 

converted menu code and shows the progress bar, along with the number of lines converted. 

 
Figure 3.2: The menu converter at work. 

8. Finally, click the Save As button to save the converted menu file in a folder and of a name of your 
choice. 

 
After the menu file has been converted, you should check the command sequences. In some cases, you 
may need to change command names and/or options. The Dialog and Menu Editor assists you in doing 
this in a convenient way. 
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The conversion program creates a log file (.log) in the working directory that contains all lines from the 
source menu file that could not be translated. Here is a sample extract from a log file: 
 

Menu item: &Snap\tCtrl+B
DIESEL instruction: $(if,$(getvar,snapmode),!.)
Line number: 103

 
AUTOCAD COMPATIBLE MENU, PALETTES AND COMMANDS 

FelixCAD delivers an AutoCAD-compatible menu file and an alias command file. The menu file is 
named facad15e.mnu and is found in the FelixCAD \support subdirectory. You load the menu with the 
Menu command. The alias command file is named facad15e.key in the \cfg subdirectory. It can be loaded 
with the Config command. 
 
Another help can be to load the AutoCAD-compatible palettes (toolbars) via the palette manager. Use the 
PalMan command. The ten AutoCAD-compatible palettes are located at the end of the selection list and 
are identified by the (FAcad) suffix. See figure 3.1. 

 
Figure 3.3: The Palette Manager opens and closes toolbars. The (FAcad) suffix indicates a palette compatible with 
AutoCAD’s toolbars. 
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4. AutoLISP Compatibility 

AutoLISP was the first programming interface Autodesk provided for AutoCAD. The addition of the 
LISP interpreter made the program more popular, since it allowed users and third-party developers to 
write specialized add-on programs.  
 
FelixCAD includes a full-featured LISP interpreter called FLISP. It has nearly all functions available in 
AutoLISP. In addition, FLISP provides a number of useful enhanced functions. Many of your LISP 
routines written for AutoCAD (and other CAD programs) can be used unmodified within FelixCAD. Just 
as in AutoCAD, you load LISP routines into FelixCAD with the load function. Applications can utilize 
the autoload mechanisms as described in this chapter. 
 
In some cases, however, you may have to modify your LISP code to work correctly with FelixCAD. This 
chapter provides a guide to adapt existing AutoLISP code for a FelixCAD implementation. Using dialog 
boxes with LISP is covered later in this manual in Chapter 6. 

 
 

Notes to Applications Developers 
 

Use this chapter as a guide and as a checklist for porting of existing AutoLISP applications to FelixCAD. There are 
only a few AutoLISP functions not recognized by FLISP. Use the atoms-family function in both systems to create a 
pair of function lists to compare names. The (flx_af) function lists the LISP functions in the kernel of FelixCAD. 
 

 
 

Figure 4.1: The dialog box displayed by the (flx_af) function. 
 

COMMAND AND SYSTEM VARIABLE NAMES 
Several LISP functions require that you pass symbolic names as arguments to the functions. In most 
cases, this does not create a problem for AutoLISP routines running in FelixCAD. Symbol table names 
are the same in FLISP as in AutoLISP. for example “LAYER” and “UCS”. This is also true for object 
snap modes and object selection keywords. 
 
There are, however, three functions where you need to check the symbolic names in your program code: 
command, setvar, and getvar. These are described in the following sections. 

The command Function 
AutoCAD commands are passed to AutoLISP via the command function. Many — but not all — 
commands in FelixCAD are identical to AutoCAD, as described in Chapter 2 “Command Compatibility.” 
A similar situation exists for command options and the sequence of command requests. 
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Notes to Application Developers 
 

When porting your AutoLISP routines to FLISP, you should first browse (or grep) your source code for command 
names and parameters: search for the command function. You may need to modify the code in some of these 
places.  
 
If you want to maintain one source code for both CAD systems, in many cases you can apply functions like entmake 
or entmod as an alternative to the command function. 
 

 

The setvar and getvar Functions 
The first argument that must be passed to the setvar and getvar functions is the name of a system 
variable. Please note in this context: 
 
• Not all of AutoCAD system variables are supported in FelixCAD.  
• A few system variables have a different name in FelixCAD but have the same purpose in AutoCAD. 
• FelixCAD has some system variables that are unknown to AutoCAD. You can probably use these for 

special purposes of your application. 
 

 
Note to Application Developers 

 
When porting your program code written for AutoLISP/ADS, first browse (or “grep”) your code for locations where you 
may have used the setvar and getvar functions.  
 

THE COMMAND FUNCTION 
In FLISP, the command function serves the same purpose as in AutoLISP. There are, however, some 
differences, which are detailed in the following sections. 

Compounded Command Sequences 
One difference from AutoLISP is FLISP that can “leave open” a command expression. This means that 
the user will be prompted for all requests of the command that are not determined by arguments of your 
application program. When the user terminates the command sequence, control is passed back to the LISP 
interpreter (your application program, in other words). 
 
This allows certain command sequences to be compounded into one command, as shown by the following 
example.The FLISP routine defines a Merge command. It inserts a block into the drawing with default 
settings for scale factor (1:1) and rotation angle (0). The user need only determine the insertion point and 
(optionally) edit the block’s attributes. 
 

(defun C:MERGE( / title fn)
(setfunhelp “C:MERGE” “QINSERT”)
(setq title “Insert External Part File”)
(FLX_FUNC_INIT)
(if (setq fn (getfiled title “” “flx” 0))

(progn
(setvar “CMDECHO” 0)
(command “.QINSERT” fn “_F” “1” “1” “_R” “CMDECHO-ON” “0”)

)
)
(FLX_FUNC_EXIT)
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(princ)
)

This advanced capability, unknown in AutoLISP, is based on the method of handling communications 
between the FLISP interpreter and the FelixCAD command interpreter. Take caution, however, in 
applying this command functionality in code that might be used by AutoLISP. 

Splitting command Expressions 
In AutoLISP, you can apply the command function in a form that does not need to necessarily terminate 
in one expression. In subsequent expressions, you utilize other AutoLISP functions before continuing 
with another command expression to continue and terminate the command that was started earlier.  
 
This mechanism is not available in FelixCAD. In other words, FLISP requires that you always pass a 
valid command name to the command function as the first argument. 
 
This problem, however, can be solved by modifying the source code. We do not know of any case where 
this did not succeed. 

PAUSE Symbol in command Expressions 
In AutoLISP, you can use the PAUSE symbol in command expressions to halt for user input. The 
PAUSE symbol causes the command interpreter to wait for a meaningful input from the user. Further 
processing of AutoLISP LISP expressions continues only after the user has provided valid data input, 
such as a point specification or a valid numerical value. This, however, does not work in FelixCAD. 
 
In FLISP, you solve the problem in several ways. One method is to use the getxxx functions to get input 
from the user before processing the command with the command function.  
Another method is to “open” the command sequence, as described above. 
 
Another way is to use the command expression inside an FLISP function that waits for meaningful user 
input. In simple cases, it is a getxxx function that corresponds to the data type requested. The 
disadvantage is that no validity check of user input is implied in this case; you can work around this by 
using application-defined functions in these places that substitute the AutoLISP PAUSE. 

FLISP FUNCTIONS WITH ALTERNATE NAMES 
Some FLISP functions have a different name from the AutoLISP function that operates the same way.  

Proprietary AutoLISP Functions Names 
Some FLISP functions have different names because the AutoLISP function names contain the word 
“acad,” which is short for AutoCAD, or “ads,” which is short for AutoCAD Development System. Both 
are proprietary to Autodesk. The following table lists the alternate FLISP function names for these  
AutoLISP functions. Notice that the syntax is identical: 

Table 4.1: FLISP Functions with Alternate Names 

AutoLISP Function FLISP Function Comments 

Acad_strlsort 
 
Syntax: 
(acad _strlsort
list) 

Stringsort 
 
Syntax: 
(stringsort list) 

Sorts a list of string-items 
alphabetically, ascending. 
In AutoCAD, externally defined 
in AcadApp, an ARX 
application.  
In FelixCAD, stringsort is a 
native FLISP function. 

Acad_colordlg 
 
Syntax: 

Getcolorindex 
 
Syntax: 

Displays the Colors dialog box, 
allowing the user to select a 
color. 
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(acad_colordlg
color_no [flag]) 

(getcolorindex [color_no]
[flag])

In AutoCAD, externally defined 
in AcadApp, an ARX 
application.  
In FelixCAD, getcolorindex is a 
native FLISP function. 

Acad_helpdlg 
 
Syntax: 
(acad_helpdlg
helpfile topic) 

Help 
 
Syntax: 
(help [topic][helpfile]
[command]) 

Displays a help topic. 
In AutoCAD, externally defined 
in function acad2000doc.lsp, 
an AutoLISP application. 
In FelixCAD, help is a native 
FLISP function.  

Ads Fdt Returns a list of strings 
containing the loaded externally 
defined applications. 

 

Differences in Error Tracing Functions 
FLISP uses different names for AutoLISP’s tracing (debugging) functions, as shown by the table below. 
FelixCAD provides the (*settrace* number) function for error tracing of LISP routines and functions. 

Table 4.2: Different Error Tracing Function Names 

AutoLISP Function FLISP Function Comments 

Trace settrace  The trace function is not supported. 
Use the (*settrace* 16) function. Note the 
difference in trace controlling: 
(lambda(fcn)(*settrace* 16) fcn)

Untrace settrace The untrace function is not supported. 
Use the (*settrace* 0) function. Note the 
differences in trace controlling: 
(lambda(fcn)(*settrace* 0) fcn)

 

Alternate Functions for Applications Loading 
Since FelixCAD does not support ObjectARX applications, you need to replace those AutoLISP 
functions in your code. In general, use the xload group of functions to load FDT applications, which are 
the equivalent to ADS in FelixCAD. The alternate functions are listed in the following table. 

Table 4.3: Replacement Functions for Loading External Applications 

AutoLISP Function Comments 

Arxload Replace with the FLISP xload function. 
Arxunload Replace with the FLISP xunload function. 
Autoarxload Replace with the FLISP autoxload function. 

 

FLISP FUNCTIONS WITH DIFFERENT ARGUMENTS 
Some FLISP functions have different arguments from the AutoLISP function of the same name. The 
following table lists those functions. Notice that the function names are identical: 
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Table 4.4: FLISP Functions with Different Arguments 

AutoLISP Function FLISP Function Comments 

Grread grread Check the arguments. 
Note that this function works different in 
AutoLISP and FLISP. 

Grtext grtext Check the arguments. 
This function is only for output at the 
status line. 

Nentselp nentselp Take care with the transformation matrix, 
which is different. 
See also the MatrixMode system 
variable. 

Ver ver Returns the version number of the LISP 
interpreter of the current program 
release. 
For example, “5.0” in FelixCAD. 

 

The getenv Function 
In AutoCAD, the getenv function retrieves the value of a specified DOS environment variable. In FLISP, 
it does not take an argument and retrieves the path settings from the felixcad.ini file (found in the 
\Windows folder) as a list of strings. 

 

UNSUPPORTED AUTOLISP FUNCTIONS 
The following table lists AutoLISP functions that are not recognized when run inside of FelixCAD: 

Table 4.5: Unsupported AutoLISP Functions  

AutoLISP Function Comments 

Menucmd The menucmd function has been used in DOS-based AutoCAD 
versions to display a context-sensitive side menu. 
This function is not supported in FLISP.  
As an alternative, use the initget function with flag 256 to display 
FelixCAD’s option menu. 

Menugroup This function is not supported in FLISP because menu groups are 
unknown in FelixCAD.  
For information about FelixCAD’s concept of menus and other 
customization items, see Chapter 3 “Customization Compatibility.” 
As an alternative, use palettes (toolbars) with the Palette 
command. 

Ssnamex This function is not supported in FLISP.  
As an alternative, if you only need to get a list of entities inside of 
the selection set, use a while loop with the ssname function. 

Ssgetfirst Grips are not supported, yet. 
Sssetfirst Grips are not supported, yet. 
Tablet In AutoCAD, the tablet function retrieves and establishes digitizer 

calibration.  
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Memory Management Functions Not Supported  
Some functions are rarely used in AutoLISP. They are not supported by FLISP because the FelixCAD 
implementation of the LISP interpreter and its memory management does not need these mechanisms. 
The following table lists memory management functions not found in FLISP: 

Table 4.6: Rarely-used AutoLISP Functions Unsupported by FLISP 

AutoLISP Function Comments 

Alloc Remove this function or replace it by a dummy:  
(lambda(x) x)

Expand Remove this function or replace it by a dummy:  
(lambda(x) x)

Xdroom 
 

The xdata size of EEDs in FelixCAD is theoretically unlimited 
(limited only by disk space). Remove this function or replace it by a 
dummy:  
(lambda (ent) 65712)

Xdsize The xdata size of EEDs in FCAD theoretically unlimited (limited 
only by disk space). Remove this function or replace it by a 
dummy. 

 

Dictionary Functions Not Supported 
The dictxxx dictionary functions in AutoLISP are strongly comparable to the tblxxx table functions found 
in FLISP. In many cases, you can apply the tblxxx functions similar or equivalent to those listed in the 
table below. 
 
The corresponding functions are not, however, identical and the management of dictionaries in the 
drawing database is different from table handling in the FelixCAD drawing database. For this reason, 
there is a loss of non-graphical application-specific data when exchanging drawings between the two 
systems. 

Table 4.7: AutoLISP Dictionary Functions Unsupported by FLISP 
AutoLISP Function Comments 

Dictadd Substitute with the tblmake function in table “APPDATA”. 
Dictdel Substitute with they tbldel in table “APPDATA”. 
Dictnext Substitute with the tblnext in “APPDATA”. 

Dictremove Substitute with the tbldel in table “APPDATA”. 

Dictrename Substitute with the tblmode and tblrename in table “APPDATA”. 

Dictsearch Substitute with the tblsearch in table “APPDATA”. 

Namedobjdict Substitute with the tblxxx functions in table “APPDATA”. 

Entmakex Use entmake in place of this function. 
For non-graphical application data, use the tblxxx function and 
table “APPDATA”. 

 
 

Notes to Applications Developers 
 
The FelixCAD drawing database contains a table called “APPDATA” that allows you to store non-graphical, 
application-specific data.  
 
The “APPDATA” table can be read and manipulated like the other symbol tables (such as Layer, Style, Ltype, 
Dimstyle, and View) with the FLISP functions that handle named objects in tables: tblnext, tblsearch, tblobjname, 
snvalid, etc. 
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ENHANCED FLISP FUNCTIONS 
FelixCAD has enhanced several FLISP functions, as described in the following sections. 

The defun Function 
You use the defun function in FLISP as in AutoLISP. The enhancement in FelixCAD is that FLISP 
allows you pass a variable number of arguments to the defun function. 

Additional FLISP Functions 
The functions listed below do not have a direct AutoLISP equivalent: 

Table 4.8: Additional Functions in FLISP 
FLISP Functions Comments 

Actcmd Reactivates a built-in command of the FCAD GDE (Graphic 
Developer’s Engine), when it had been previously deactivated by 
function delcmd. 

Delcmd Deactivates (deletes) a built-in GDE command. This disables the 
command for the user.  
The argument specifies the name of the command. 

Entcheck Verifies if the entity specified by ename is (still) valid in the current 
drawing database.  
Returns the entity name if ename is valid or is contained in a block 
definition of the current drawing; otherwise it returns nil. 

Entpos Sets the database pointer in the entity section to an absolute or 
relative position.  
Returns the name of the entity found at that position. 

Symbtos Returns any LISP expressions in a string. 
Tan Returns the tangent of an angle. 
Tbldel Deletes a record (specified by the name of the item) in a specified 

table a record, if the table entry is not referenced in the drawing. 
FLISP Functions Comments 

Tblmake Generates a new table-entry, as described by an association list. 
Tblmod Modifies an existing table-entry, as described by an association list. 
Tblpurge Purges an entire table of the specified type and deletes all not-

referenced entries. 
Tblrename Allows the renaming of a table entry. The entry old_name is 

replaced by the entry new_name. 
Tblset Sets a table entry as current entry. In the table specified by 

table_type the entry item_name is set as current (default or active). 
An associated system variable is updated. 

 

THE A2FLISP CONVERTER 
FelixCAD provides a utility, called A2FLisp, that allows an interactive conversion of LISP files written 
for AutoLISP. The program is a tool for porting AutoLISP source code to FLISP. Its main task is to assist 
you during the conversion process. It shows you the location of possible problems and describes the 
related difficulty. It allows you to edit the source code at the highlight location and for a simple text 
replacement, if needed. 
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The tool is located in the \xconvert\a2flisp folder of an installed FelixCAD. For more information, read 
the a2flisp.doc documentation file in the same folder. 
 

  
Figure 4.2: The A2FLisp program interactively checks AutoLISP code for incompatibilities. 

FREQUENTLY ASKED QUESTIONS 
Some of the most-often asked questions from application developers are about autoloading code, 
extended entity data, and protecting FLISP routines.  

Autoload Mechanism 
Q: Is it possible for my application to automatically load routines when the system starts up? 
A: FelixCAD provides several possibilities to load application specific routines automatically: 
• autoload and autoxload: These functions are provided since FelixCAD 4.0 (in a LISP routine itself). 

They work just like in AutoCAD. 
• S::STARTUP mechanism: You can apply startup function S::STARTUP in FLISP, just as in 

AutoLISP. 
• Menuload mechanism: LISP code included with an .mnl file is loaded automatically when a menu is 

called with the same name as the .mnl file. This mechanism, added to FelixCAD version 4.0, 
corresponds to the same mechanism in AutoCAD. 

Extended Entity Data 
Q: Is extended entity data (xdata) supported? 
A: FLISP and FDT completely support the attachment of extended entity data to drawing objects. For 
detailed information, see the description of the regapp, entget, entmod, and handent functions in the 
Customization and Programmer’s Guide. 

 
Note to Applications Programmers 

 
The xdroom and xdsize functions are unknown in FLISP and FDT. The method of xdata memory management in 
FelixCAD makes these functions obsolete. 
 

Protecting LISP Routines 
Q: How can I protect my LISP program code? 
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A: Use the Protect program comes with FelixCAD. See the \tools folder on the CD-ROM. This program 
allows you to encrypt your LISP files so that they cannot be read with a text editor. 
 
Please note that you can not use protected FLISP routines in AutoCAD. Similarly, you cannot run 
AutoLISP files that have been protected by AutoCAD. 
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5. ADS Compatibility 

AutoCAD provides an API (application programming interface), which allows third party developers to 
write applications in C/C++. In AutoCAD, it is called ADS, short for “AutoCAD Development System.”  
The FelixCAD equivalent is called FDT, short for “FelixCAD Developer’s Toolkit.” FDT is an API with 
an outstanding compatibility to the ADS interface. (FelixCAD does not support the equivalent of 
AutoCAD’s ObjectARX.) 
 
Numerous third-party developers provide applications built for FelixCAD based on FDT — either as 
FelixCAD add-on applications, or as stand-alone OEM applications. 
 
The majority of these developers use C and C++ (preferably Microsoft Visual C/C++) to build their 
applications. Some use other high-level programming languages. 

UNDERSTANDING ADS COMPATIBILITY 
The primary difference between FDT and ADS functions is that FDT uses the fdt_ prefix, whereas ADS 
uses the ads_ prefix. Please note that: 
 
• ADS has some function names that use other prefixes, such as acad_ and acrx_. 
• FDT’s dialog-related functions use the dlg_ prefix. 
 
The differences between FDT and ADS functions are listed in the tables found in this chapter. Dialog box 
functions are listed in Chapter 6 “Dialog Box Compatibility.” 

The ads2fdt.h Include File 
FelixCAD provides the ads2fdt.h include file, which redefines ads_ function names to their fdt_ 
equivalents. 
 
The asd2fdt.h header file and libraries are provided on the FelixCAD CD-ROM. 

Porting ADS Applications to FDT 
To execute existing applications in FDT, simply recompile the source code using the ads2fdt.h header file 
and link the FDT libraries. 
 
For more information, read the online documentation of the FDT function library provided as Acrobat® 
Acrobat file: fdtapi5.pdf. Also, have a look at the ads2fdt.h file. 

INITIALIZATION AND DEFINITION DIFFERENCES 
As an application developer, note that there is a difference in the application initialization between ADS 
and FDT, as shown in the following table.  

Table 5.1: Initialization and Definition Differences 
ADS Initialization FDT Initialization 
  

AcrxEntryPoint(AcRx::AppMsgCode
msg, void*);
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Void ads_init (int argc, char
*argv[]);

Int ads_link (int cbc);

FDT_INIT

int fdt_app_init(void);

int fdt_app_exit(void)

Int ads_defun _((const char
*sname, short funcno));

Int ads_regfunc (int (*fhdl)
(void), int fcode);

int fdt_register (const char
*CommandName, const char
*FunctionName);

See also: fdt_register_param()

 
The following code fragment provides a template for FDT-based applications and demonstrates the 
mechanism of initialization and registering functions: 
 

#include <windows.h>
#include “fdt.h”

/* Initialization of the Windows DLL (defined in fdt.h) */
FDT_INIT
/* DLL’s LibMain (defined in fdt.h) */
/* Initialization of the application’s DLL */
/* Required to be contained in any application! */
FDT_DLLEXPORT int fdt_app_init()
{

int iCode;
/* Registering the internal function “func_1” (function name f1) */

iCode = fdt_register(“func_1”,”f1”);
/* Registering the external function “c:func_2” (function name f2)*/

iCode = fdt_register(“c:func_2”,”f2”);
/* Further FDT statements may follow */

.

.

.
/* DLL is loaded in “preload-mode”! = return 1! */

return RTPRELOAD;
}

/* De-Initialization of the application’s DLL (exit function) */
/* Required to be contained in any application! */
FDT_DLLEXPORT int fdt_app_exit()
{
/* E.g. release memory */

.

.

.
return 0;

}
FDT_DLLEXPORT int f1(void)
{

fdt_printf(“Internal Function func_1 (Procedure Name f1)”);
.
.
.
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return 0;
}
FDT_DLLEXPORT int f2(void)
{

fdt_printf(“External Function c:func_2 (Procedure Name f2)”);
.
.
.

return 0;
}

 

FUNCTIONS WITH MINOR DIFFERENCES 
Not all FDT functions are completely equivalent to ADS functions. Some are different; however, these 
functions fulfill the same purpose. Usually, modification of your source code can be done without much 
effort. Conditional compile is recommended in these cases. 
 

 
Note to Applications Developers 

 
FDT has its own memory management. This means that memory dynamically allocated with the functions 
fdt_malloc(), fdt_strmalloc(), fdt_getvar(), and fdt_fgetenv() can only be released by fdt_free() and fdt_strfree(), 
respectively. 
  
 
The following table compares ADS and FDT functions that are partially compatible: 

Table 5.2: FDT Functions Partially Different from ADS Functions 
ADS Function FDT Function Comments 
void *acad_malloc ( 
  size_t sz) 

void *fdt_malloc ( 
  unsigned int sz) 

Both functions allocate a region of 
memory for an array. 

int ads_getenv ( 
  const char *VarName,  
  char  *Result) 

int fdt_getenv ( 
  char *VarName,  
  char * Ini_section,  
  char * Ini_file,  
  int length,  
  char * Result) 

The ADS function retrieves a value 
from the current environment. 
The FDT function gets a value from 
the current environment or from a 
named INI file. See also  
fdt_fgetenv(). 

int ads_getcfg ( 
  const char *sym,  
  char *var,  
  int len) 

int fdt_getcfg ( 
  const char *sym,  
  char  *var,  
  int len); 

The ADS function retrieves 
application data from the AppData 
section of the acad.cfg file. 
The FDT function retrieves 
application data from the AppData 
section of the appdata.ini file. 

int ads_getcname ( 
  const char *Cmd,  
  char **Result) 

int fdt_getcname ( 
  const char *Cmd,  
  char **Result); 

The ADS function retrieves the 
localized name of a command from 
the language independent name of a 
command and vice versa. 
The FDT function retrieves the 
primary command name from a 
localized name. 

int ads_getfiled ( 
  const char *Title,  
  const char *Default,  
  const char *ext,  
  int flags,  
  struct resbuf *Result) 

Int fdt_getfiled ( 
  const char *Title,  
  const char *Default,  
  const char *ext,  
  int flags,  
  struct resbuf *Result); 

The ADS function allocates memory 
for the path name string in the Result 
argument. 
The FDT application must allocate 
sufficient memory for the result buffer 
where the filename is returned 
(including the path). To do so, use 
fdt_strmalloc(). 
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ADS Function FDT Function Comments 
int ads_grtext ( 
  int Box,  
  const char *Text,  
  int hl) 

Int fdt_grtext ( 
  char *Text) 

The ADS function displays the specified 
text in the menu area or in the status 
area. 
The FDT function always displays the 
text in the status line. 

int ads_initget ( 
  int val,  
  const char *kwl); 

Int fdt_initget ( 
  int val,  
  const char *kwl);  

The FDT function uses a bit-coded sum 
of val with the control bit 256 to display 
keyword(s) in the options menu.  

int ads_setcfg ( 
  const char *sym,  
  const char *val); 

Int fdt_setcfg ( 
  const char *sym,  
  const char *val); 

The ADS function writes application 
data to the AppData section of the 
acad.cfg file. 
The FDT function writes application 
data to the AppData section(s) of the 
appdata.ini file. The .ini file is created 
automatically in the configuration 
directory, if it does not exist. 

int ads_setfunhelp ( 
  const char *FunctionName,  
  const char HelpFile,  
  const char Topic,  
  int iCmd); 

int fdt_setfunhelp ( 
  char *FunctionName,  
  char *HelpFile,  
  char *Topic); 

In ADS, the parameter iCmd must be in 
accordance to the ads_defun() 
parameter, which identifies the function 
in subsequent kInvkSubrMsg message 
from AutoLISP. 
This parameter is not required in FDT. 

int ads_setview ( 
  const struct resbuf *view,  
  int vport); 

int fdt_setview ( 
  const struct resbuf *view,  
  int vport); 

In ADS, if the argument vport is set to 
0, the current viewport receives the new 
view. AutoCAD counts viewport 
numbers beginning with 2, in ascending 
order. 
In FDT, if vport is -1, the current 
viewport receives the new view. 
FelixCAD counts the viewport numbers 
beginning with 0 in ascending order 

struct resbuf *ads_tblsearch 
( 
  const char *TableName,  
  const char *Sym,  
  int setnext) 

Struct resbuf * fdt_tblsearch ( 
  char *TableName,  
  char *Sym) 

In ADS, the setnext argument specifies 
whether the ads_tblsearch() call 
affects the next call to ads_tblnext() or 
not. 
FDT does not provide a default 
sequence for fdt_tblsearch(). 
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ADS Function FDT Function Comments 
int ads_vports ( 
  struct resbuf **VList) 

int fdt_vports ( 
  struct resbuf **VList) 

In ADS, if the TILEMODE system 
variable is set to 1 (on), the returned list 
describes the current viewport 
configuration, beginning with 2 and 
counting in ascending order. The 
corners of the viewports are expressed 
in values between 0.0 and 1.0. 
In FDT, if the TILEMODE system 
variable is set to 1 (on), the returned list 
describes the current viewport 
configuration, beginning with the 
viewport number 0 and counting in 
ascending order. The corners of the 
viewports are variable because FCAD 
provides windows based on the multiple 
document interface (MDI). 

 

ADS FUNCTIONS WITHOUT DIRECT EQUIVALENTS IN FDT 
Some ADS functions are not supported in FDT. These include the functions as listed in the following 
table. Where applicable, you find information on “work-arounds”.  

Table 5.2: ADS Functions Not Supported by FDT 
ADS Function Comments 

acad__msize Use standard C commands. 
acad__strdup Use standard C commands. 
acad_calloc Use standard C commands. 
acad_realloc Use standard C commands. 
ads_abort, acrx_abort Not supported. 
ads_asetenv Use standard C-commands. 
ads_dictadd Dictionary function. 
ads_dictnext Dictionary function. 
ads_dictrename Dictionary function. 
ads_dictsearch Dictionary function. 
ads_entmakex Dictionary function. 
ads_exit Not supported. 
ads_getappname Not supported. 
ads_getfuncode ADS interface function; not required in FDT. 
ADS Function Comments 

ads_getstringb Of minor importance (ads_getstring with buffersize); use 
fdt_getstring(). 

ads_link ADS interface function; not required in FDT. 
ads_menucmd Functionality is implemented by fdt_initget(). 
ads_namedobjdict Dictionary function. 
ads_regappx Dictionary function. 
ads_ssgetfirst Grips related function; not supported. 
ads_ssnamex Selection method information; not supported. 
ads_sssetfirst Grips related function; not supported. 
ads_tablet Not supported. 
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ads_xdroom In FDT, extended entity data size is unlimited; not required in 
FDT. 

ads_xdsize In FDT, extended entity data size is unlimited; not required in 
FDT. 

ads_xstrcase Not supported. 
ads_xstrsave Not supported. 
adsw_acadDocWnd Not supported. 
adsw_acadMainW Use fdt_gethandle() to get main window handle. 

 

FUNCTIONS UNIQUE TO FDT 
The following table lists functions that are unique to FDT: 

Table 5.3: FDT Functions Not Found in ADS 
FDT Function Comments 

fdt_actcmd() Reactivates a built-in command of the FCAD GDE (Graphic 
Developer’s Engine), which had been previously deactivated by 
fdt_delcmd(). 

fdt_addimage2lib() Adds an image file (BMP or WMF) to the specified image 
library. Image libraries .ilb files store multiple image files within 
one library file. 

fdt_appinters() Returns the implied (apparent) intersection point of two entities 
found in the specified snap points pt1 and pt2. 

fdt_boundingbox() Returns the lower left and the upper right corners of the 
smallest box that encloses the entire drawing, a selection set, or 
an entity. 

fdt_bspline2poly() Converts a B-spline curve back to a regular 2D polyline. 
fdt_call_notify_app() Notifies an application of critical operations, including New, 

Open, Save, Close, and Exit. 
fdt_catrom2poly_2d() Converts a 2D Catmull-Rom curve back to a 2D-polyline. 
fdt_compfont() Compiles a font source file (.shp or .fnt) to a system binary font 

file (.fsh). 
fdt_copyresbuf() Copies a linked result buffer list. Copies the result buffer 

source_rb and returns in target_rb the start address of the 
new allocated result buffer. 

fdt_deldbmodhook() Deletes (uninstalls) a registered database modification hook 
function (removes it from the hook registration list). 

fdt_delimagefromlib() Removes a specified image from the specified image library .ilb 
file. 

fdt_delmousehook() Deletes the current active hook function, which had been 
installed to retrieve mouse click event information. 

fdt_delselecthook() Deletes (uninstalls) a registered hook function for entity 
selection control. 

fdt_delcmd() Deactivates (deletes) a built-in CAD-Engine command. This 
disables the command for the user. 

fdt_entcheck() Verifies if the drawing entity specified by ename is (still) valid in 
the current drawing database. 

fdt_entget_dbhook() Returns the defining data of a drawing entity specified by 
ename contained in the current temporary (virtual) Update 
Database. 

fdt_entmod_dbhook() Allows modification of the defining data of an entity that is a 
member of the current Update Database based upon the 
information supplied as the linked result buffer list. 
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fdt_entmod_type() Allows to request the type of modification. This function can only 
be used within a database modification hook function! 

fdt_entnext_dbhook() Retrieves an entity name next_ename (which follows the entity 
specified by ename) from the temporary (virtual) Update 
Database, which is established temporarily as soon as a user 
command or program operation is going to modify the drawing 
database to allow to control database modification by 
accordingly hook functions. 

fdt_entpos() Sets the database pointer in the entity section to an absolute or 
relative position and returns the name of the entity found at that 
position. 

fdt_exit_dragmode() Terminates the usage of a drag mode previously installed by 
fdt_init_dragmode(). 

fdt_flxclose() Closes the current drawing (with or without saving). 
fdt_flxclosevport() Close the current viewport. 
Fdt_flxnames() Returns a list containing the database numbers and the 

filenames of the drawings currently opened in a linked result 
buffer list. 

fdt_flxnew() Opens a new drawing specified by filename.  
fdt_flxopen() Opens an existing drawing specified by filename in read-write or 

read-only mode. 
fdt_flxsave() Performs a quick save of the current drawing in FelixCAD’s 

native binary drawing format (.flx). 
fdt_flxsaveas() Saves the current drawing as specified by filename.  
fdt_getactvport() Returns the ID of the current drawing and its current viewport.  
fdt_getcolorindex() Displays the Colors dialog box to retrieve a color number 

specified by the user. 
fdt_getcolorref() Retrieves for a FelixCAD color number a Windows COLORREF 

structure 
fdt_getcursor() Retrieve the current cursor style setting: crosshair, rubberband, 

snap box, select box, or window. To set a new cursor, see the 
function fdt_setcursor(). 

fdt_getcurr_mousepos() Returns the current mouse position as a 3D point. in the current 
user coordinate system (UCS). 

fdt_getflxinfo() Reads drawing annotations stored in the FLX drawing file.  
fdt_getimagetype() Retrieve the type of an image stored within the specified Image 

Library (.ilb file). 
fdt_hatch() Hatches the entities of a selection set specified by sname. 

fdt_init_dragmode() Allows an application to utilize several drag or rubberband 
modes provided by the FCAD Graphic Developer’s Engine. 

fdt_input() A very powerful general user input function: reacts directly on 
user input.  
It has some characteristics in common with fdt_grread(), but 
allows the user to input object snap options and transparent 
commands, and apply them by the application. 

fdt_norm_dxfcode() Normalizes a given DXF Group Code to a standard result type 
(RTINT, RTSTR ...) as defined within the include file fdtcodes.h.

fdt_pcontour() Create a polyline boundary contour.  
fdt_poly2bspline() Converts a 2D polyline to a B-spline curve. 
fdt_poly2catrom_2d() Converts a 2D polyline to a 2D Catmull-Rom curve. 
fdt_purgedbmodhooklist
() 

Deletes all registered hook functions for drawing database 
modification control. 

fdt_purgeselecthooklist() Deletes (uninstall) all registered hook functions for entity 
selection control. 
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fdt_set3dview() In a single operation, set a 3D view direction and zooms to a 
specified region. 

fdt_setactvport() Sets another drawing as current drawing, or sets another 
viewport as active by determining the ID of a currently opened 
drawing and the ID of the drawing’s viewport. 

fdt_setcolorref() Assigns a Windows COLORREF structure to a FelixCAD color 
number. 

fdt_setcursor() Sets a new cursor style for successive operations.  
fdt_setdbmodhook() Registers and installs a hook function to control entity 

modification of the drawing database. 
fdt_setflxinfo() Writes new drawing information to an FLX drawing file. 
fdt_setmousehook() Registers a hook function which is called with any mouse click 

to a drawing window (mouse click event in the drawing). 
fdt_setselecthook() Registers and installs a hook function fnSelHook to supervise 

entity selection. 
fdt_ssdbnr() Returns the database ID to verify for which drawing the 

specified selection set name sname is valid. 

fdt_strfree() Releases the memory of a string allocated by the function 
fdt_strmalloc(). 

fdt_strmalloc() Allocates memory of a string in certain applications, The 
function must be used to modify variables of type rstring in a 
result buffer list of type struct resbuf. 

fdt_tbldel() Deletes from a specified table a record specified by the name of 
the item, but only if the table entry is not referenced in the 
drawing. 

fdt_tblmake() Creates a new table entry. In the current drawing, a new table 
item is created based on the data contained in the result buffer 
list tbl_record. 

fdt_tblmod() Modifies a table record.  
fdt_tblpurge() Purges an entire table of the specified type and deletes all not-

referenced entries. 
fdt_tblren() Renames a table entry (table item).  
fdt_tblset() Sets a table entry as current entry. In the table specified by 

tbl_type the entry item_name is set as current (default or 
active). An associated system variable is updated automatically.

fdt_wmfout() Writes the specified area of a drawing to a Windows metafile 
(Aldus Metafile). 
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6. Programmable Dialog Boxes 

DCL (Dialog Control Language) is used by AutoLISP and ADS to define the layout of dialog boxes in 
AutoCAD. The drawback to DCL is that Autodesk does not provide a visual tool to design the layout of 
dialog boxes.  
 
Like AutoCAD, FelixCAD allows you to create dialog boxes for your LISP and C applications. 
FelixCAD DLG files contain dialog box descriptions, just as DCL files do. The format and syntax of 
these files, however, differs. FelixCAD does not (yet) provide direct support of AutoCAD’s DCL syntax.  
 
However, FelixCAD comes with a tool that dramatically shortens the process of converting DCL files 
into DLG files. The following sections describe the differences between AutoCAD’s and FelixCAD’s 
dialog boxes. 

DIALOG AND MENU EDITOR 
FelixCAD provides a tool named DME (short for Dialog and Menu Editor) that you can use as a visual 
workbench for creating and modifying dialog boxes. This method is easily understood by less-
experienced users and offers the added advantage of immediately seeing the result. No programming 
skills are necessary to create dialog boxes. The DME can also be used for application prototyping. 
 
You access DME from within FelixCAD by selecting File > Resource Manager > Run Dialog and 
Menu Editor from the menu bar, or by typing the DlgEdit command. 

 
Figure 6.1: The Dialog and Menu Editor allows you to interactively create dialog boxes. 

In summary, using DME reduces errors and increases overall efficiency. For more information, read 
Chapter 10 “Creating and Editing Dialog Boxes” of the FelixCAD Customization and Programmer’s 
Guide.  

CONVERTING DCL -DIALOGS 
The FelixCAD Dialog and Menu Editor converts and imports dcl dialogs directly during opening. This 
functionality can be selected under the pull-down File>AutoCAD Import>Dialogs…. 
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Figure 6.2: The Dcl2Dlg utility converts AutoCAD DCL files to FelixCAD format. 

Before you start converting your DCL files, make sure that the base.dcl (and any other DCL files 
referenced by your DCL source files) is located in the same directory as the DCL files to be converted.  
 
The base.dcl file is not converted because the file is used only by AutoCAD to include global defined 
dialog entries. 
 
After conversion, the position and size of the dialog controls are not totally optimized in the resulting 
files. You may have to edit the resulting .dlg files with the Dialog and Menu Editor. In some very rare 
cases, one control might be hidden by another. 
 
In general, we recommend:  
• In DME, activate the tab setting mode and toggle from one dialog control to another with the Tab key 

to evaluate whether there are hidden controls in the dialog box. 
• Make use of the alignment tools in DME to rearrange the controls. 
• Please check the dialog control properties via the Property dialog. 

 
To run a batch routine to convert multiple DCL files in one process, create a batch file. cvt_samp.bat is a 
sample file that shows how to this. The syntax is: 

DCL2DLG Input_DCL_file [Output_DLG_file]

Directory paths names can be used in input and output file names. 
 

INITIATING A DIALOG BOX 
There are some differences in how AutoCAD and FelixCAD handle dialog boxes. The most important 
difference is how they initiate and interact with dialog controls.  
 
A typical AutoLISP code fragment loads the DCL file, sets the controls, takes actions on the controls, and 
then starts.  
 
In contrast, FLISP loads the dialog box, then calls the start_dialog (or Dlg_DialogStart) function with a 
function_name as an argument that contains the user dialog interaction function. 
The following sample LISP code shows the differences: 
AutoCAD AutoLISP     FelixCAD FLIX 
(if (not (new_dialog “setlayer”
dcl_id)) (exit))

;; initialize list box

(start_list “list_lay”)

(mapcar ‘add_list longlist)

(end_list)

;; Display current layer, show
initial layer name in

;; edit box, and highlight list box

(setq old-idx lay-idx)

(if (/= lay-idx nil) (laylist_act
(itoa lay-idx)))

(set_tile “cur_layer” (getvar
“clayer”))

(action_tile “list_lay” “(laylist_act
$value)”)

(action_tile “edit_lay”
“(lay_edit_act $value)”)

(defun InitDlg ()

;; initialize list box

(start_list “list_lay”)

(mapcar ‘add_list longlist)

(end_list)

;; Display current layer,

;; show initial layer name in

;; edit box, and highlight list box.

(setq old-idx lay-idx)

(if (/= lay-idx nil)

(laylist_act (itoa lay-idx)))

(set_tile “cur_layer” (getvar
“clayer”))

(action_tile “list_lay”
“(laylist_act $value)”)

(action_tile “edit_lay”
“(lay_edit_act $value)”)

(action_tile “accept” “(test-ok)”)
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(action_tile “accept” “(test-ok)”)

(action_tile “cancel” “(reset-lay)”)

(if (= (start_dialog) 1)

(progn

...

(action_tile “cancel” “(reset-lay)”)

(if (not (new_dialog “setlayer”
dcl_id))(exit))

(if (= (start_dialog “(InitDlg)”) 1)

(progn

...

DIALOG BOX EQUIVALENTS 
The following table lists the FLISP dialog box functions and their equivalents in AutoLISP. Most of the 
functions are identical. There are, however, some differences. 
 
The difference between AutoCAD and FelixCAD in initializing dialog box controls with the start_dialog 
function is discussed above. 
FelixCAD has special functions to control sliders in dialog boxes, whereas AutoCAD uses the set_tile 
and get_tile functions. 
 
Another difference is that there is a separate function (dlg_ImageLib) to display an image from a library 
file in an image box of a dialog box; in AutoLISP you use the slide_image function. Note that you can 
import entire slide libraries from AutoCAD into FelixCAD image libraries. In this way, you can use the 
same pictures in image controls of your dialog boxes. 
 
The following table shows that FelixCAD has some extra functions that might be useful for your 
application. For example, you can display bitmaps and WMF files or drawing preview bitmaps as images 
in your dialog boxes. 

Table 6.1: Comparison of AutoLISP and FLISP Dialog Box Functions 

AutoLISP Function FLISP Function Comments 

… Dlg_ImageWmf Displays WMF file in an image box.
… Dlg_ImageBmp Displays BMP file in an image box. 
… Dlg_ImagePrev Displays a preview bitmap stored 

in the specified FLX file in an 
image box. 

… Dlg_ListSetColumWidth Sets width of columns in a list box. 
… Dlg_ListTabStops Sets tab stops in a list box. 
… Dlg_TileSetFont Sets a font for a control element. 
action_tile action_tile 

Dlg_TileAction 
Assigns an action to a tile. 

add_list add_list 
Dlg_ListAdd 

Adds or modifies a list box item. 

client_data_tile client_data_tile 
Dlg_TileClientData 

Assigns data to a control. 

dim_tile dim_tile 
Dlg_TileDim 

Returns the size (height and width) 
of a control. 

done_dialog done_dialog  
Dlg_DialogDone 

Closes a dialog. 

done_positioned_dialog done_positioned_dialog 
Dlg_DialogDonePositioned 

Closes a dialog and returns the last 
screen position of that dialog. 

 
AutoLISP Function FLISP Function Comments 

End_image end_image 
Dlg_ImageEnd 

Terminates the operation of an 
image box. 
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End_list end_list 
Dlg_ListEnd 

Terminates operation in a list box. 

fill_image 
 

fill_image 
Dlg_ImageFill 

Draws a filled rectangle in an 
image box. 

Get_tile get_tile 
Dlg_TileGet 

Reads the current value of a 
control. 

get_tile Dlg_SliderGet 
 

Reads the values and properties of 
a slider control. 

load_dialog load_dialog  
Dlg_DialogLoad 

Loads a dialog file. 

mode_tile mode_tile 
Dlg_TileMode 

Determines the display mode of a 
control. 

new_dialog new_dialog  
Dlg_DialogNew 

Provides a new dialog (loaded to 
memory). 

new_positioned_dialog new_positioned_dialog 
Dlg_DialogNewPositioned 

Provides a new dialog at a 
specified screen position (loaded to 
memory). 

set_tile set_tile 
Dlg_TileSet 

Sets a control to a value. 

set_tile Dlg_SliderSet Sets the values and properties of a 
slider. 

slide_image slide_image 
Dlg_ImageSlide 

Displays a slide file (.sld) in an 
image box. 

slide_image Dlg_ImageLib Displays an image from an image 
library (.ilb file). Within image 
libraries graphics of type Bitmap, 
WMF, or Slide can be stored. 

start_dialog start_dialog 
Dlg_DialogStart 

Initializes and displays a dialog. 

start_image start_image 
Dlg_ImageStart 

Start function to display a bitmaps 
or vector graphic in an image box. 

start_list start_list 
Dlg_ListStart 

Start function for list operations in a 
list box. 

term_dialog term_dialog 
Dlg_DialogTerm 

Terminates all open dialogs. 

unload_dialog unload_dialog 
Dlg_DialogUnload 

Unloads a dialog file. 

vector_image vector_image 
Dlg_ImageVector 

Draws a vector in an image box. 

Release Notes on Dialog Box Functions 
The FLISP functions Dlg_ImageSlide, Dlg_ImageLib, and Dlg_ImagePrev (respectively 
Dlg_ImageSlide(), Dlg_ImageLibrary(), and Dlg_ImagePreview() in FDT) have been added in version 
4.0 of FelixCAD. 
 
FLISP 4.0 has implemented the following dialog box functions with AutoLISP-like names that are 
equivalent to existing FLISP function: 

Table 6.2: New FLISP Dialog Box Function Names 

AutoLISP Function  FLISP Function 

Action_tile dlg_tileaction 
add_list dlg_listadd 
client_data_tile dlg_tileclientdata 
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dimx_tile dlg_tiledimx 
dimy_tile dlg_tiledimy 
done_dialog dlg_dialogdone 
end_image dlg_imageend 
end_list dlg_listend 
fill_image dlg_imagefill 
get_tile dlg_tileget 
load_dialog dlg_dialogload 
mode_tile dlg_tilemode 
new_dialog dlg_dialognew 
set_tile dlg_tileset 
slide_image dlg_imageslide 
start_dialog dlg_dialogstart 
start_image dlg_imagestart 
start_list dlg_liststart 
term_dialog dlg_dialogterm 
unload_dialog dlg_dialogunload 
vector_image dlg_imagevector 

 

Dialog Box Functions in FDT 
FDT provides equivalent dialog box functions to FLISP. For information on the meaning of the functions 
please refer to the FLISP section on the previous pages. 

Table 6.3: Comparison of ADS and FDT Dialog Box Functions 

ADS Dialog Box Function FDT Dialog Box Function 

ads_action_tile() Dlg_TileAction() 
ads_add_list() Dlg_ListAdd() 
ads_client_data_tile() Dlg_TileClientData() 
ads_dimensions_tile()  Dlg_TileDimensions() 
ads_done_dialog()  Dlg_DialogDone() 
ads_done_positioned_dialog()  Dlg_DialogDonePositioned() 
ads_end_image()  Dlg_ImageEnd() 
ads_end_list() Dlg_ListEnd() 
ads_end_list()  Dlg_ListEnd() 
ads_fill_image()  Dlg_ImageFill()  
ads_get_tile() Dlg_TileGet() 
ads_mode_tile() Dlg_TileMode() 
ads_new_dialog()  Dlg_DialogNew() 
ads_new_positioned_dialog()  Dlg_DialogNewPositioned() 
ads_set_tile() Dlg_TileSet() 
ads_slide_image() Dlg_ImageSlide() 

See also: Dlg_ImageLibrary() 
ads_start_list() Dlg_ListStart() 
ads_term_dialog()  Dlg_DialogTerm() 
ads_vector_image() Dlg_ImageVector() 
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As described earlier (in the section that discussed the equivalent LISP functions), the FDT function to 
start a dialog is requires to pass a callback function as a third function. This contains the code to initialize 
the dialog. In contrast, ADS initialization is assembled between the ads_new_dialog() and 
ads_start_dialog() functions. 
int ads_start_dialog(
ads_hdlg hdlg,
int *status);

int Dlg_DialogStart(
const dlg_hdlg hdlg,
int* status,
const DLGINITFUNC
init_dialog_callback);

Unsupported ADS Functions 
These ADS functions are not supported in FDT: 

Table 6.4: Unsupported ADS Functions 

ADS Function Comments 

ads_get_attr() Not supported, provided from struct 
dlg_callback_packet- member ‘key‘ 

ads_get_attr_string() Not supported, provided from struct 
dlg_callback_packet- member ‘key‘ 

 

Unique FDT Functions 
The following table lists dialog box functions that are unique to FDT: 

Table 6.5: Unique FDT Functions 

FDT Function  

Dlg_TileSetFont()   
Dlg_ListSetTabStops()  
Dlg_ListSetColumnWidth()   
Dlg_SliderGet()   
Dlg_SliderSet()  
Dlg_ImageBmp()   
Dlg_ImagePreviewBmp()  
Dlg_ImageLibrary()  
Dlg_ImageWmf()  
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